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Avid Xpress DV Terms and Concepts

This section explains the following terms and concepts to help you 
understand the Avid Xpress DV editing process:

• Media Files

• Clips

• Subclips

• Sequences

• Bins

• Projects

• The Attic Folder

• Programs

Media Files
Media files store source 
material.

When you record source material from a camera or deck, or when you 
import computer graphic files into your Avid Xpress DV project, the 
material is saved in media files on your system’s media drive or drives. 
One media file is created for each track of video or audio. For a video 
with a stereo sound track, three media files are created: one track of 
video and two tracks of audio. Media files are stored in the OMFI 
MediaFiles folder and each media drive has its own OMFI MediaFiles 
folder.

n Even though your media files contain the actual source material for the 
program, you never manipulate the media files directly. Instead, you move, 
copy, and edit clips, subclips, and sequences, which are pointers to the media 
files.
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Clips
Clips point to media 
files.

When you record media, Avid Xpress DV creates another file, called a 
master clip, on your system’s internal drive. The master clip is simply a 
pointer to its corresponding media file, which is located in the OMFI 
MediaFiles folder on a media drive. A media drive can be inside the 
computer (an internal media drive) or outside the computer (an external 
media drive).

While editing your video, you create other clips, such as graphic clips 
and effects clips. You make your edits by modifying clips, and the 
corresponding media files remain unchanged. This feature allows you 
to easily create and undo edits without destroying your original 
material.

Because you work with clips instead of media files, you can create 
virtually unlimited versions of a program without creating multiple 
copies of the source material, which is stored in extremely large files.

Subclips
Subclips are sections 
that you mark within 
clips.

Subclips are sections of clips that you want to use in your program. You 
create a subclip by marking IN (start) and OUT (end) points in a clip, 
pressing and holding the Alt key, and dragging the clip to the bin. The 
subclip is composed of the material between the IN and OUT points.

Video deck

Master clip

Media drive

OMFI
MediaFiles
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c A subclip points to a media file’s master clip. You must not delete 
the master clip from which a subclip was created. If you delete the 
master clip, you will lose the information in the subclip.

Sequences
A sequence is a
program created from 
one or more clips and 
subclips.

You can join different clips and subclips to create a sequence. A 
sequence can include edited material from master clips and subclips, 
new clips created when you add effects during the editing process, 
and material from other sequences. 

Master

Subclip  

clip

Sequence

Subclip

Master clip

Sequence

Handle

IN point OUT point

Handle
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A sequence is composed of marked material from clips, subclips, and 
other sequences. The material outside the IN and OUT points remains 
in the media file’s master clip. These segments of material are called 
handles. Handles are important; you need them to trim cuts and create 
transition effects between segments. For more information about 
trimming cuts, see “Trimming” on page 163. For more information 
about transition effects, see “Effects Editing” on page 172.

Like clips and subclips, a sequence contains pointers to media files, 
which are stored in the OMFI MediaFiles folder. If you delete a clip 
used to create a sequence, the sequence still displays the media, 
because the sequence contains its own pointers to the media files.

Bins
You organize your 
footage in bins.

Clips, subclips, and sequences are organized and stored in bins. 
Traditionally, a bin is a place where film editors store reels of film. In 
Avid Xpress DV, bins represent a database for organizing the material 
for a project.

Projects
A project consists of one 
or more bins.You edit 
within a project. 

You gather the material you need to create a program in a project. Each 
project contains information about bins, clips, subclips, sequences, and 
the program in the Timeline. You might have several projects on your 
system, but you can work on only one project at a time.

Sequence

Clip

Subclip

OMFI
MediaFiles
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The Attic Folder
For a complete 
description of retrieving 
bins from the Attic 
folder, see the Avid 
Xpress DV User’s Guide 
or Help.

Avid Xpress DV saves copies of your current project and its bins at 
regular intervals and whenever you save or close a project or bin. 
These auto-save files are stored in the Attic folder at the top level of the 
internal hard drive. If you lose work due to a power outage or system 
error, open the Attic folder and look for a project or bin of the same 
name with the file name extension.bakxx, where xx is the version 
number. For example, the first backup file for the bin Rough Cut 
would be named Rough Cut.bak01. Later versions would be named 
Rough Cut.bak02, Rough Cut.bak03, and so on.

Programs

A program consists of one or more sequences. You can use clips, 
subclips, and sequences to build a program. A program is your final 
creation; you can output your program to tape, CD-ROM, or the Web 
when you are finished.

The Avid Xpress DV File System

The following illustration shows the different kinds of Avid Xpress DV 
files and where they are stored. The Avid Xpress DV application folder 
is stored on your computer’s internal hard drive. The Avid Projects 
folder is also stored on an internal drive; the location varies, 
depending on your installation. An OMFI MediaFiles folder is stored 
on each media drive. Media files must be stored on a separate, 
Avid-approved media drive that is guaranteed to be fast enough to 
support video playback.
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For complete 
information about 
folders and files, see the 
Avid Xpress DV User’s 
Guide or Help.

Project Workflow

The following sections illustrate the four stages of a typical 
Avid Xpress DV project: starting a project, preparing to edit, editing a 
sequence, and generating output.

Complete procedures for each stage are included in the printed 
manuals, online books, and Help.

Media drive

Avid Avid

Project

Project

Bin A Bin B
Supporting

Avid Xpress DVSettings

Help

OMFI
MediaFiles

 ProjectsXpress DV

Files
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Starting a Project

1. Turn on your 
equipment in the 
correct order and start 
the software. (Speakers 
and external media 
drives are optional.)

2. Select or create a new 
user and project: the job 
that will result in one or 
more finished sequences.

3. Create and organize 
bins.

4. Back up your project 
on a regular basis.

Starting a project involves the following steps:

 

2. Select or create a user and project.

3. Create and organize bins.

4. Back up the project.

1. Turn on and start your Avid system.
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Preparing to Edit

1. (Optional) Import 
your log files into the 
bins, or log the material 
manually.

2. Record your DV 
footage, creating media 
files and master clips.

3. Work with bins and 
clips to organize your 
source material for easy 
access during editing.

4. (Optional) Build a 
storyboard to begin 
previsualizing your 
final cut before editing.

Preparing to edit involves the following steps:

3. Sort and organize clips in the bins.

4. Previsualize with storyboards.

2. Record footage, creating
master clips and media files.

1. (Option) Import shot logs into the bin.
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Editing a Sequence

1. View your clips in 
advance and mark IN 
points and OUT points, 
or create subclips based 
on selected portions of 
your master clips.

2. Build your sequence 
using editing controls 
with the Timeline, 
Source pop-up 
monitors, and the 
Composer monitor.

3. Fine-tune your edits 
and effects by using 
functions of the various 
edit modes, such as 
Segment mode, Trim 
mode, and Effect mode.

4. Adjust and mix 
multiple audio tracks 
and prepare for final 
playback or output, 
using the Audio tool and 
Audio Mix tool.

5. Return to editing if 
further adjustments are 
required.

Editing a sequence involves the following steps:

Composer
monitor

Source
pop-up

Timeline

2. Edit with Timeline and monitors.

3. Fine-tune edits and effects.

4. Fine-tune audio pan, volume, and EQ.

5. Screen and 1. Screen, mark, and subcatalog footage.
continue editing
as necessary.

monitor
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Generating Output

Export material for 
audio sweetening or 
graphics enhancement 
in a third-party 
application, for 
incorporating into a 
multimedia project, or 
for publishing on the 
Internet.

Record the final 
sequence to tape as a 
digital cut.

Generate an EDL for 
online videotape 
editing.

Generating various forms of output based on your sequence involves 
selecting among several options:

Export material for additional processing,
for incorporating into a multimedia project,

Record a digital cut directly to tape.

Generate an EDL for online
videotape editing.

or for publishing on the Internet.

DV
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CHAPTER 5

Starting a Project and 
Creating a Simple Sequence

This chapter begins the tutorial section of this guide. In this chapter 
you’ll practice the following tasks:

• Starting Avid Xpress DV

• Using the Select User and Project Dialog Box

• Creating a Simple Sequence

• Closing the Project and Quitting the Application

Before starting this chapter, make sure you have installed the tutorial 
files (see “Installing the Avid Xpress DV Tutorial Files” on page 52).
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Starting Avid Xpress DV

You start the Avid Xpress DV application the same way you start most 
Windows applications. 

1. Click the Start button.

2. Point to Programs, point to Avid, and select Avid Xpress DV.
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3.   Select User and Project dialog box appears. 
If you are the first user on the system, the Select User and Project 
dialog box appears as shown in the following illustration.

For this tutorial, you will use the project called either Introducing 
Avid (NTSC).
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Using the Select User and Project Dialog Box 

To open a project, you select a user and a project from the Select User 
and Project dialog box. You also use this dialog box to create a new 
user or a new project.

Creating a User

For this tutorial, create a new user.

1. Click the New User button in the Select User and Project dialog 
box.

The New User dialog box appears.

By default, the Windows login name appears.

2. Delete the default name, type your name, and click OK. 

The Select User and Project dialog box reappears with your name 
highlighted in the list of Avid Users.
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Selecting and Opening a Project

For this tutorial, we’ve already created a project for you.

1. Select Introducing Avid (NTSC) from the Avid Projects list. 

2. Click OK.

The Project window opens. 

Look at the title bar of the window. It contains the name of the project 
and the name of the user. In this example, the user is named Editor. 
Your project window will contain your user name.

Two other windows appear: the Composer window and the Timeline 
window. You’ll learn about these windows in Chapter 7.
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Creating a Simple Sequence

Before continuing further in the tutorial, you can create a simple 
sequence right away. A sequence is a program made up of one or more 
clips (see “Sequences” on page 72). These steps will get you started 
quickly; you’ll find more thorough instructions and explanations later 
in the tutorial.

The sequence uses footage from the Introducing Avid project that you 
just opened. The following illustration shows the Project window.

Source Clips bin
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Follow these steps to create a sequence:

1. In the Project window, open the Source Clips bin by 
double-clicking the bin icon.

The Source Clips Bin window opens and displays a list of clips.

2. From the list of clips, double-click the icon for the Editor at 
keyboard clip.

The Editor at keyboard clip opens in a window. This window is 
known as a Source pop-up monitor.

Editor at keyboard clip
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3. Click the Mark Clip button, which is located at the bottom of the 
Source pop-up monitor. 

IN and OUT points appear at the beginning and end of the clip, 
which indicate that the entire clip will be edited into the sequence.

Mark Clip button

IN point OUT point
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4. Click the image area of the Source pop-up monitor and drag it 
anywhere in the Timeline window.

n If you have more than one bin open, a dialog box appears and asks you to 
select a bin in which to store the sequence. Select Source Clips.

Congratulations! You’ve just created your first sequence. The clip 
appears in the Timeline and in the Composer monitor.

Notice the vertical blue line at the end of the Timeline.This line is 
called the position indicator. The position indicator is parked on the 

Position indicator
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last frame of the sequence, so this frame is the one displayed in the 
Composer monitor. 

5. Now add some music to the sequence. 

a. In the Source Clips bin, double-click the icon for the Music 
track clip.

The clip opens in a Source pop-up monitor. There is no image 
because the clip has only audio.

b. Click the image area and drag the clip to audio track A1 in the 
Timeline. Drag the clip so that the A1 track is outlined, as 
shown in the following illustration, and then release the 
mouse button.

If you make a mistake, 
choose Undo from the 
Edit menu to undo your 
last action.

6. In the Timeline, make sure the position indicator is at the 
beginning of the sequence. If not, drag the position indicator as far 
as you can to the left.

Drag the position indicator here.
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7. Click the Play button below the Composer monitor to review your 
sequence.

Press the Play button again to stop playing the sequence at any 
time.

Now look in the Source Clips bin. The sequence is saved in the bin 
with the name Untitled Sequence.01. Delete the sequence. You’ll 
create a new one in Chapter 7.

8. In the Source Clips bin, click the Untitled Sequence.01 icon and 
press the Delete key on the keyboard.

The Delete dialog box appears.

Play button
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9. Click OK.

You’ve deleted the sequence, but not the source footage.

10. Close the Source Clips bin by clicking the Close button in the 
upper right corner of the window.

Next Steps

You’ve finished this chapter of the tutorial. You can either:

• Close the project and quit the application and continue the tutorial 
at a later time.

• Continue on to the next chapter.

Closing the Project and Quitting the Application

To close the project and 
quit the application 
immediately, choose 
Exit from the File menu 
or click the Close button 
in the Avid Xpress DV 
title bar.

If you want to close the project and quit the application:

1. Click the Project window to activate it, and then click the Close 
button.

The system saves and closes the project. The Select User and 
Project dialog box appears.

2. Click Quit.

A dialog box appears and asks if you want to quit the application.

3. Click Leave.

The application quits and you see the Windows desktop.

The next time you open the project, select your user name and project 
name, and resume the tutorial with the next section.

Close button
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CHAPTER 6

Playing and Marking Clips

In Chapter 5 you learned how to start a project. In this chapter you’ll 
practice the following tasks:

• Exploring the Project Window

• Opening a Bin

• Viewing Clips

• Playing Clips in a Source Pop-up Monitor

• Marking IN and OUT Points

• Playing a Sequence in a Source Pop-up Monitor

• Using Timecode to Find a Frame

• Creating Subclips

• Clearing IN Points and OUT Points

• Saving Your Work

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, select your user name and 
the Introducing Avid project, and then click OK.

If you have not worked on the previous chapters — Start the 
application, create a new user, select the Introducing Avid project, and 
then click OK.
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Exploring the Project Window
Click in the Project 
window and press the 
F1 key to open Help for 
the Project window.

The Project window must remain open whenever you are working in 
Avid Xpress DV. Depending on the button you click, the Project 
window displays a list of bins, a list of settings, or information about 
your system.

n If the Project window becomes hidden by other windows, bring it forward by 
choosing Project from the Tools menu.

The Bins Display

The Bins display lists the bins, or storage areas, created to hold your 
clips and sequences (you’ll learn more about bins later in this chapter). 
For the Introducing Avid project, we’ve supplied you with three bins:

• QuickTime Movies

• Sequences

• Source Clips
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The Info Display

Click the Info button at the top of the Project window. You see the 
format of the project (NTSC or PAL). You can get information about 
your system by clicking the Fast Menu button in the lower left corner 
of the screen, and then choosing Profile, Memory, or Hardware from 
the pop-up menu.

Click the Bins button to return to the Bins display.

Opening a Bin

The term bin comes from film editing and refers to a container for 
holding film clips (see “Bins” on page 73).

Let’s open a bin now. In the list of bins in the Project window, 
double-click the Source Clips icon. The Source Clips bin opens.

Fast Menu button
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Most of the clips you’ll use in your sequence are displayed in this bin.

Viewing Clips

You can view the information in a bin in three different ways:

• Text view displays columns of information about your clips.

• Frame view displays each clip as a single representative image.

• Script view displays each clip as a single frame with text 
information about the clip.

Text View Frame View 

Name heading

button button

Script View button
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Using Text View

Let’s look at Text view.

1. Click the Text View button (T) in the lower left corner of the bin.

If the button is highlighted, you are already in Text view.

The bin displays columns of information about each clip. For 
explanations of these columns, see the Avid Xpress DV User’s Guide 
or press the F1 key for Help.

You can rearrange the clips in the bin by sorting on a particular 
column. Let’s sort alphabetically by clip name.

2. Click the Name heading in the bin.

3. Choose Sort from the Bin menu.

The clip names are rearranged in alphabetical order.
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Using Frame View

Now let’s look at Frame view.

1. Click the Frame View button (F) in the lower left corner to see a 
picture-frame representation of each clip in the bin.

n The order of clips is different from the order in Text view. You can rearrange 
clips in either view independently of the other.

You can change the size of the frames if you want.

2. Choose Reduce Frame or Enlarge Frame from the Edit menu.

To change frame size at the keyboard, you can also press Ctrl+K 
(Reduce Frame) and Ctrl+L (Enlarge Frame).

3. Choose Fill Window from the Bin menu.

The clips are arranged in neat rows and columns in the bin.

4. If some clips are now off the screen, click and drag the window 
corner in the lower right corner of the Source Clips bin. 
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Using Script View

Now let’s look at Script view.

Click the Script View button (S) in the lower left corner of the bin.

In Script view, the system combines the features of Text view with 
Frame view, and adds space for typing notes or script. The frames are 
displayed vertically on the left side of your screen with a script text 
box to the right of each clip. Clip information is displayed above the 
text box.

Switching Between Views

It’s easy to switch between views: click the T button for Text view, the 
F button for Frame view, and the S button for Script view. For this 
tutorial, you can use whichever view you prefer, except when 
performing a storyboard edit (see “Storyboard Editing the Clips” on 
page 152).
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Playing Clips in a Source Pop-up Monitor

A Source pop-up monitor is a window in which you play the clips for 
your project. You can play clips in three different ways:

• Using the keyboard

• Using the buttons on the screen, below the Source pop-up monitor

• Using the blue position indicator (the “blue bar”)

In this section you’ll try different ways to play clips. As you edit, use 
the ones you prefer.

Using the Keyboard to Play Clips
Your system is shipped 
with a set of labels that 
you can place on the 
keys of your keyboard.

The keyboard for your Avid system includes many special control 
keys, as shown in the following illustration.

This illustration shows the U.S. English keyboard. For layouts of other 
keyboards, choose Keyboard from the Settings scroll list.

Stop key

Play/Step/Shuttle keysStep keys Home keyEnd key
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In this section you’ll experiment with different ways to play clips. 

1. In the Source Clips bin, open the clip named Editor at keyboard 
by double-clicking the icon (in Text view) or anywhere in the 
image (in Frame view).

The Editor at keyboard clip appears in a Source pop-up monitor.

2. Press the Home key (between the main keyboard and the numeric 
keypad) to move the position indicator to the start of the clip.

3. Press the End key, just below the Home key, to go to the end of the 
clip. The blue position indicator moves to match your directions.

4. Press the Home key again to go to the start of the clip.

5. Press the L key (Play) on the keyboard to play the clip forward at 
normal speed.

There is no audio for the Editor at keyboard clip.

n The small size of the Source pop-up monitor might cause the footage to look 
jerky. The footage will look smoother in the Composer monitor and the Client 
monitor.
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6. Press the space bar on the keyboard to stop playback at any point.

7. Press the L key again to play the clip forward at normal speed. 
Press the key repeatedly to play the clip forward at 60, 90, 150, and 
240 frames per second (NTSC) or 50, 75, 125, and 200 frames per 
second (PAL). 

8. Press the J key (Reverse Play) on the keyboard to play the clip 
backward at normal speed. Press the key repeatedly to play the 
clip backward at 60, 90, 150, and 240 frames per second (NTSC) or 
50, 75, 125, and 200 frames per second (PAL). 

9. Press the K key (Pause) on the keyboard to pause playback.

10. To move forward or backward at slow speed, press and hold the 
K key while you press and hold the L or J keys.

11. Use the 1, 2, 3, and 4 keys to step through the footage forward or 
backward in 1-frame or 10-frame increments.

Step 10
Frames Backward

Step 10
Frames Forward

Step 1
Frame Backward

Step 1
Frame Forward
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Using Buttons and the Position Indicator to Play Clips

Two additional ways to play clips are:

• Clicking buttons that appear under a Source pop-up monitor

• Dragging the blue position indicator through the position bar to 
scroll through a clip

Now play through the Editor at keyboard clip by using buttons and 
the position indicator.

1. Click the Play button under the Source pop-up monitor.

2. Click the Play button again to stop playback at any point.

To step forward or 
backward 10 frames, 
hold the Alt key while 
you click the Step 
Forward or Step 
Backward 
button.

3. Step through the footage forward or backward in 1-frame 
increments by using the Step Forward and Step Backward buttons 
under the Source pop-up monitor.

4. Locate the blue position indicator in the position bar in the Source 
pop-up monitor.

To step several frames 
forward, click just to the 
right of the position 
indicator.

5. Click to the left of the position indicator to step several frames 
back in the clip.

6. Step through the clip by clicking different spots in the position bar.

7. Drag the position indicator to the left, then to the right, to scroll 
through the clip.

Play 
 

Position
bar

Step Step

Position indicator

Backward Forward
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Marking IN and OUT Points

Before you start to create your sequence, you need to mark the 
segments of the clips you want to use. In this section you’ll mark 
IN and OUT points for some clips you’ll use later to build your 
sequence. You’ll also learn how to use timecode and frame offset to 
locate IN and OUT points.

n The instructions in this section use the keyboard to mark IN and OUT points, 
but you can also click the equivalent buttons below the Source pop-up 
monitor.

Marking the First Clip

Let’s mark IN and OUT points for the Editor at keyboard clip.

1. Go to the head (start) of the clip by pressing the Home key. Then 
use the Step Forward and Step Backward (3 and 4) keys to locate 
the frame where the letter A begins to appear on the monitor 
screen.
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Your clip might already have IN and OUT points. Your new edit 
points will overwrite the old edit points.

2. Mark an IN point by pressing the Mark IN (I) key.

A white sawtooth pattern appears on the left edge of the frame.

3. Drag the position indicator toward the end of the clip, where the 
explosion appears on two monitors, and before it fades away.

4. Mark an OUT point by pressing the Mark OUT (O) key.

A white sawtooth pattern appears on the right edge of the frame.

The system saves your IN and OUT points until you change them.

5. Close the Editor at keyboard clip by clicking the Close button.

The system automatically saves your IN and OUT points.
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Marking Another Clip

Now mark the IN and OUT points for the Eyeball clip. This time, 
instead of using the Step keys, use the J-K-L keys to play the clip.

1. Open the Eyeball clip.

n In this tutorial, “open a clip” means to double-click its icon in a bin, so that it 
opens in a Source pop-up monitor.

2. Locate the frame where the letter A of the word Avid appears in 
the pupil of the eyeball (after the second blink). Press and hold the 
K key and press the L key to go forward or the J key to go 
backward in slow motion.

Use the 3 and 4 keys to locate the precise frame.

3. Mark an IN point by pressing the I key.
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4. Step forward a few frames after the D appears.

5. Mark an OUT point by pressing the O key.

6. Close the Eyeball clip.

Playing a Sequence in a Source Pop-up Monitor

So far you have played clips in Source pop-up monitors. You can also 
play a sequence (a program made up of one or more clips) in a Source 
pop-up monitor. 

You might be curious to see what your final sequence will look like. 
We have supplied a finished sequence for you. To play it:

1. Click the Project window to display and activate it.

The Project window might be hidden behind the Source Clips bin. 
You can choose Project from the Tools menu to bring the window 
forward.

2. Open the Sequences bin.
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3. Open the Introducing Avid sequence.

4. Press the Home key to go to the beginning of the sequence. Play 
the sequence in the Source pop-up monitor, using the keyboard or 
buttons, or a combination of both.

5. Close the Introducing Avid sequence.

6. Close the Sequences bin.

Using Timecode to Find a Frame

Your Avid Xpress DV system uses timecode to identify each frame of a 
clip. 

About Timecode

Timecode is an electronic indexing method that denotes hours, 
minutes, seconds, and frames that have elapsed on a videotape. For 
example, a timecode of 01:03:30:10 denotes a frame that is marked at 
1 hour, 3 minutes, 30 seconds, and 10 frames.

NTSC video (the video format used mainly in the United States) uses 
one of two formats: drop-frame timecode and non-drop-frame timecode.

Drop-frame timecode is designed to match the NTSC scan rate of 29.97 
frames per second (fps). Two frames of timecode are dropped every 
minute except for the tenth minute. No video frames are actually 
dropped. Drop-frame timecode is indicated by semicolons between 
the digits; for example, 01;00;00;00. DV cameras that use the NTSC 
format use drop-frame timecode.

Non-drop-frame timecode tracks NTSC video at a rate of 30 fps and is 
indicated by colons between the digits; for example, 01:00:00:00. 
Non-drop-frame timecode can be easier to work with, but does not 
provide accurate timing for NTSC broadcast.
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PAL video (the video format used in many countries other than the 
United States) uses a scan rate of 25 fps. Timecode is indicated by 
colons. There is no need for drop-frame timecode in PAL video.

You can change the starting timecode of a sequence or, for NTSC 
projects, the type of timecode. See “Changing the Timecode of the 
Sequence” on page 209 and the Avid Xpress DV User’s Guide.

Using Timecode to Mark IN and OUT Points

You can mark IN and OUT points by using timecode as your reference 
point. If you know the timecode for the frame you want to mark, you 
can go to that frame instantly by typing it on the numeric keypad.

In this section, you’ll use timecode to reach a specific location. First, 
you need to display the appropriate timecode information in the 
Tracking Information display.

1. Open the Hand and keyboard clip.

2. Place the pointer in the gray title bar area over the Tracking 
Information display, until the pointer changes to a downward 
arrow.

Tracking Information display
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3. When the pointer changes to a downward arrow, click to display 
the Tracking Information pop-up menu, and then choose TC, V1 
(timecode for track Video 1) from the menu. A check mark means 
it is selected.

For information about 
the other choices in the 
Tracking Information 
menu, see the 
Avid Xpress DV User’s 
Guide or place the 
pointer over the 
Tracking Information 
display, click the right 
mouse button, and 
choose What’s This?

The timecode refers to the frame displayed in the Source pop-up 
monitor.

n After you change the display for one Source pop-up monitor, all subsequent 
Source pop-up monitors you open use the same display.

4. Use the Play and Step buttons to locate the frame with the 
timecode 01:08:14:18 (NTSC) or 00:01:42:23 (PAL). Look for the 
number in the Tracking Information display.

5. Click the Mark IN button.

6. Let’s use 2 seconds of this clip. You can determine the OUT point 
by adding 2 seconds to the timecode of the IN point, as shown in 
the following examples:

01:08:14:18 (NTSC)
+ 2:00
01:08:16:18

or

00:01:42:23 (PAL)
+ 2:00
00:01:44:23

Timecode shows the following:
Hours
Minutes
Seconds
Frames
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Because Avid Xpress DV counts the frame it is parked on, you will 
actually mark one frame more than 2 seconds.

7. Type 01:08:16:18 (NTSC) or 00:01:44:23 (PAL) on the 
numeric keypad. 

n You don’t need to type zeros that start the timecode. In addition, the system 
inserts the colons for you. So you only need to type 1081618 (NTSC) or 
14423 (PAL). This guide provides the complete timecode, but you can use 
these shortcuts to type the numbers.

As you start typing, a window opens in the middle of the Source 
pop-up monitor, showing the numbers you type.

8. Press the Enter key on the numeric keypad. The position indicator 
locates the specified frame. 

The Timecode window displays the current number. 

n To locate frames by using timecode and the numeric keypad, you must show 
timecode in the Tracking Information display. For example, the display must 
show track V1 to go to a specific frame on the V1 track.

Timecode 
entered

Tracking Information
display
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9. Click the Mark OUT button.

10. Close the Hand and keyboard clip.

Using Frame Offset
Whenever you use the 
numeric keypad, you 
must press the Enter 
key on the numeric 
keypad after typing the 
number. 

You can also use the numeric keypad to move the position indicator 
forward or backward a specified number of frames. This technique is 
called frame offset. Let’s mark an IN point for the Editor at keyboard 3 
clip and then use frame offset to locate the OUT point.

1. Open the Editor at keyboard 3 clip.

2. Use the numeric keypad to type 01:23:24:02 (NTSC) or 
00:03:07:15 (PAL), and then press the Enter key.

3. Click the Mark IN button.

4. Advance 29 frames (NTSC) or 24 frames (PAL) by typing +29 or 
+24 on the numeric keypad and pressing the Enter key. 

Advancing 29 or 24 frames is the equivalent of advancing 
1 second, because Avid Xpress DV counts the frame it is 
parked on.

5. Advance 2 more seconds by typing +129 (NTSC) or +124 (PAL) 
and pressing Enter. The system inserts the colons for you. 

If you want to move 
back a certain number 
of frames, type a minus 
sign (–) instead of a 
plus sign (+) in front of 
the number.

6. Mark that frame as the OUT point by clicking the Mark OUT 
button.

7. Close the Editor at keyboard 3 clip.

Creating Subclips

Now you’ll copy portions of one clip into shorter clips, called subclips 
(see “Subclips” on page 71). Subclipping is a great way to organize 
your footage into manageable units.
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1. Open the Lab clip.

2. Go to the start of the clip.

3. Review the clip by clicking the Play button or by dragging the 
blue position indicator. There are two parts of the clip that you’ll 
copy into separate subclips.

4. Use the numeric keypad to type 01:24:53:19 (NTSC) or 
00:04:10:22 (PAL), and then press the Enter key.

5. Mark an IN point.

6. Type 01:24:57:16 (NTSC) or 00:04:14:20 (PAL).

7. Mark an OUT point.

8. Press and hold the Alt key, click the image area of the clip, and 
drag it from the Source pop-up monitor to the Source Clips bin.

As you begin dragging, the pointer changes to a hand attached to 
a small box.

The subclip has the 
name of the original 
clip, followed by Sub.n, 
where n is the number 
of times the master clip 
has been cataloged to 
that bin. 

A new item called Lab.Sub.01 appears in the Source Clips bin. 
The name is highlighted.

9. Delete the name Lab.Sub.01 and rename the subclip Lab 1A.

Clearing IN Points and OUT Points

Now you’ll clear previous IN and OUT points, mark new IN and OUT 
points, and create a new subclip.

1. Bring the Lab clip forward by choosing Lab from the Windows 
menu. 

2. Press the Clear IN key (D) and Clear OUT key (F).

You can also click the corresponding buttons beneath the monitor.

3. Mark an IN point at 01:25:00:11 (NTSC) or 00:04:17:03 (PAL).
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4. Mark an OUT point at 01:25:07:16 (NTSC) or 00:04:25:12 (PAL).

5. Press and hold the Alt key, click the image area of the clip, and 
drag it from the Source pop-up monitor to the Source Clips bin.

The clip name is highlighted in the Source Clips bin.

6. Delete the name Lab.Sub.02 and rename the subclip Lab 1B.

7. Close the Lab clip.

8. Close the Source Clips bin.

Saving Your Work

By default, Avid Xpress 
DV includes an 
Auto-save function set 
at 15 minutes. You can 
view or change this 
setting in the Bin 
settings box, which you 
access from the Settings 
scroll list in the Project 
window.

You’ve done a lot of work marking clips. Saving your bins and other 
project information would be a good idea.

1. Click the Project window to activate it.

2. Choose Save All from the File menu.

Next Steps

You’ve prepared some clips that you’ll use in your sequence. In the 
next chapter you’ll start to edit your sequence. You can continue to the 
next chapter, or quit this session (see “Closing the Project and 
Quitting the Application” on page 101). The next time you open the 
project, the windows will be in the same position.
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CHAPTER 7

Creating a Sequence

In this chapter, you begin editing the Introducing Avid sequence by 
completing the following tasks:

• Working in the Avid Xpress DV Window

• Making the First Edit

• Opening a Sequence

• Opening and Using the Tool Palette

• Splicing in an Audio Clip

• Exploring the Timeline

• Splicing in a Video Clip

• Splicing a Clip into the Middle of a Sequence

• Undoing an Edit

• Splicing in a Music Track

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, select your user name and 
the Introducing Avid project, and then click OK.

If you have not worked on the previous chapters — Start the 
application, create a new user, select the Introducing Avid project, and 
then click OK.
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Working in the Avid Xpress DV Window

You’ve been working in a single large window, labeled Avid Xpress 
DV. Like other Microsoft windows, you can minimize it, maximize it, 
and close it by using the buttons on the right side of the title bar.

Within the Avid Xpress DV window, you can manage the Timeline, 
bins, and Source pop-up monitors in the same way. The difference is 
that, when you reduce or resize these windows, they remain within 
the Avid Xpress DV window, rather than appearing on the Windows 
desktop.

n You cannot minimize the Composer window.

Minimizing Avid Xpress DV Windows

To get more space 
below the Timeline, 
right-click the 
Windows toolbar, 
choose Properties from 
the pop-up menu, and 
deselect the Always on 
Top check box.

Try minimizing some windows now. 

1. Open the Source Clips bin.

2. Click the Minimize button on the Source Clips window and the 
Timeline. The windows shrink to small title bars at the bottom of 
the Avid Xpress DV window.

3. Close the Source Clips bin by clicking the Close button.

4. Return the Timeline to full size by clicking the Restore button.

Managing your Avid Xpress DV windows will become more 
important as your projects become larger. 

Minimize
Maximize

Close

Restore button
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Default Locations for the Avid Xpress DV Windows

The Composer, Timeline, and Project windows have default sizes and 
locations to maximize the available space on your desktop, as shown 
in “Dragging a Video Clip and Creating a Sequence” on page 129.

If you want to return these windows to the default locations, click the 
window and choose Home from the Windows menu.

Making the First Edit

In this section, you’ll make your first edit and create a sequence by 
completing the following tasks:

• Playing a Video Clip

• Dragging a Video Clip and Creating a Sequence

• Moving and Renaming the Sequence

Playing a Video Clip

Let’s start by playing the clip that will begin the sequence. 

1. In the Project window, open the QuickTime Movies bin.

2. Double-click the Opening logo.mov clip to display it in a Source 
pop-up monitor. Play the clip through.

Notice the .mov file name extension. This indicates that the clip is 
a QuickTime movie that was created by using a special effects 
program. You can import a QuickTime movie into Avid Xpress 
DV, which changes the QuickTime movie to a DV clip. We’ve 
already imported the movie for you.
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Dragging a Video Clip and Creating a Sequence

Now edit the clip to create a sequence.

1. Make sure the Timeline is open and visible. If it is not, choose 
Timeline from the Tools menu.

2. Click the Source pop-up monitor that contains the Opening 
logo.mov clip. If the monitor is not visible, open it from the 
QuickTime Movies bin.

3. Click the Mark Clip button on the Source pop-up monitor. 

The Mark Clip button marks IN and OUT points at the beginning 
and end of the clip, so that the entire clip is edited into the 
sequence.

4. Click the image area of the clip and drag it to the Timeline 
window.

You’ve just created a sequence. 

n If you have more than one bin open, a dialog box appears and asks you to 
select a bin in which to store the sequence. Select QuickTime Movies.

Look at the Timeline. You should see the Opening logo.mov clip 
in track V1. The first frame is the IN point you marked in the clip; 
the last frame is the OUT point you marked. The position indicator 
rests on the last frame of the clip, as shown in the following 
illustration.
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The sequence also appears in the Composer monitor. The image is 
black because the last frame of the clip is black. Notice the right 
angle and vertical line in the lower right corner of the Composer 
monitor. The right angle indicates the end of a cut and the vertical 
line indicates the end of the sequence.

Position indicator

Right angle and
vertical line
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When you want to 
bring an open bin or 
monitor to the 
foreground, you can 
click anywhere in it or 
choose its name from 
the Windows menu.

5. Click anywhere in the Composer monitor to activate it.

6. Press the Home key to move to the head of the sequence.

7. Click the Play button at the bottom of the Composer monitor to 
play the clip in the sequence.

8. Close the Opening logo.mov clip.

Moving and Renaming the Sequence

You can create a new 
sequence by choosing 
New Sequence from the 
Clip menu. 

Because the QuickTime Movies bin was the only bin open, the 
sequence appears in that bin. By default, Avid Xpress DV names the 
sequence Untitled Sequence.01. Now let’s move the sequence to the 
Sequences bin and change its name.

1. In the Project window, click the Bins button.

2. Open the Sequences bin.

3. In the QuickTime Movies bin, click the icon in front of the name 
Untitled Sequence.01 and drag it to the Sequences bin.

4. Click the name Untitled Sequence.01 to select it.

The name is highlighted.



132

5. Type Rough Cut and press the Enter key.

This is the sequence you’ll be working with for this tutorial. The 
sequences Rough Cut 1, Rough Cut 2, and Rough Cut 3 are 
supplied for those who prefer not to build their own sequence (see 
the notes at the beginning of each chapter).

6. Close the QuickTime Movies bin.

7. Close the Sequences bin.

By closing the Sequences bin, you also close the sequence.

Opening a Sequence

In Chapter 6 you opened a sequence in a Source pop-up monitor (see 
“Playing a Sequence in a Source Pop-up Monitor” on page 118). To 
open a sequence for editing, you need to drag it into the Composer 
monitor or the Timeline.

1. Open the Sequences bin.

2. Drag your Rough Cut sequence to the Composer monitor.

The sequence appears in the Composer monitor and the Timeline.

You need to keep the Sequences bin open to continue working on 
your sequence. You can minimize the bin to save workspace on your 
desktop.

Opening and Using the Tool Palette

Before you continue with your editing, familiarize yourself with the 
Tool palette. So far you have been using buttons that appear below the 
Source pop-up monitor or keyboard equivalents. The Tool palette 
provides you with additional buttons for navigating and editing. 
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Opening and Tearing Off the Tool Palette
You can also open the 
Tool palette from the 
Fast Menu button on a 
Source pop-up monitor.

Open the Tool palette by clicking the Fast Menu button under the 
Composer monitor.

To use a button on the Tool palette, just click it. You can also “tear off” 
the palette and drag it to a different location.

1. If the Tool palette is not open, click the Fast Menu button.

2. Drag the pointer over the buttons and then outside the border of 
the Tool palette. You should see a dotted line outline. Drag the 
outline to another location. You see the complete Tool palette, with 
a title bar and Close button.

You can drag the Tool palette to a different location; just click and hold 
anywhere on the Tool palette and drag it wherever you want. You can 
also resize it to a square or a single row, to suit the way you want to 
work.

Fast Menu button
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All buttons in 
Avid Xpress DV have 
ToolTips.

To view the name of each button, slowly drag the pointer across each 
button. You should see a small yellow window pop up with the name 
of each tool. You’ve probably seen these pop-ups in other Windows 
applications; they’re called ToolTips. 

Displaying Button Names

You can display a shortened name on the button itself by selecting an 
option in the Interface Settings dialog box.

1. In the Project window, click the Settings button.

2. From the Settings scroll list, double-click Interface.

The Interface dialog box appears.

3. Select the option Show Labels in Tool Palette.

4. Click OK.

You see names on the first row of buttons. 

5. Click the border of the Tool palette and drag it until you see the 
second row of buttons. 

You can keep these names or remove them by deselecting the 
Show Labels in Tool Palette option from the General tab in the 
Interface dialog box. For this tutorial, you might want to keep the 
labels visible.

6. Close the Tool palette by clicking the Close button.
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Splicing in an Audio Clip

The next clip, Narration, provides the voice of an off-camera narrator, 
or voice-over. This clip includes only audio. 

To edit this clip into the sequence, you’ll use the Splice-in button on 
the Tool palette. Splicing is a film term that refers to joining together 
two pieces of film.

n Now that you’ve had some experience marking and playing clips, the 
instructions will be less specific about which keys to press or buttons to click.

1. In the Project window click the Bins button.

2. Open the Source Clips bin.

3. Open the Narration clip.

4. Go to the head of the clip.

5. Play some or all of the clip.

The clip appears black because it’s audio only.

Using Digital Audio Scrub to Locate a Specific Frame of Audio

The term audio scrub originated in the film industry. It describes the 
process of “scrubbing” a magnetic audiotape across the playback 
heads to monitor a portion of sound. This process helps isolate 
portions of audio to accurately mark edit points.

Your Avid Xpress DV system uses a digital version of audio scrub to 
locate a specific frame of audio. Use it now to locate the first frame of 
audio in the clip.

1. Go to the head (start) of the Narration clip.

2. Press the Caps Lock key to activate digital audio scrub.
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3. Play the clip again. Stop at the approximate place where the voice 
begins.

4. Use the Step keys to locate the first frame of the voice.

When you use the Step keys, a frame of audio sounds scratchy or 
buzzlike. You might need to increase the volume of your speakers 
to hear the first frame of audio.

5. After you have located the first frame of audio, step back one 
frame and mark an IN point.

6. Go to the tail (end) of the clip.

7. Step back to find the last frame of audio, and then step forward 
one frame. 

8. Mark that frame as the OUT point.

Press the Caps Lock key again to deactivate digital audio scrub.

Playing IN to OUT

Now you can play only the marked portion of the clip to make sure 
you have marked IN and OUT points correctly.

Press the Play IN to OUT (6) key on the keyboard.

The clip plays from the IN point to the OUT point. If the audio sounds 
cut off, redo your IN and OUT points.

Splicing in the Clip

Now you’re ready to make the edit.

1. In the Timeline, make sure the position indicator is at the end of 
the Opening logo.mov clip.

2. Click the Fast Menu button on the Composer monitor to open the 
Tool palette.
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3. Click the Splice-in button (the button with the yellow arrow) on 
the Tool palette.

The second clip is now edited into the sequence. Your Timeline 
should look like the one in the following illustration.

4. Close the Narration clip.

Reviewing Your Edits

Review what you’ve done so far. 

1. Click the Composer monitor and go to the head of the sequence.

2. Play the sequence.

You should see the opening logo without sound, followed by the 
narration without video. You’ll be adding more clips later.

n If you try to play a sequence, and the outline of the Composer monitor flashes, 
another window is covering the Composer monitor. Click the Composer 
monitor to bring it forward or move the window that is covering it.
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Exploring the Timeline

You can get context-
sensitive Help by 
pressing F1 or clicking 
the right mouse button 
and choosing What’s 
This?

Before you edit in the next clip, take a few minutes to explore the 
Timeline window. The Timeline is the graphical representation of the 
clips, effects, and other elements that make up your sequence.

Displaying More or Less Detail in the Timeline

The scale box on the scale bar, below the Timeline on the left side of the 
window, expands and contracts the area centered around the blue 
position bar. The scale box allows you to zoom in to focus on a specific 
area of your sequence or to zoom out to see the whole sequence. 
Scaling the Timeline is especially useful when you have a lengthy 
sequence with many edits.

The Timeline always expands or contracts proportionally on both 
sides of the position indicator.

1. In the Timeline, click the transition point between the first two 
clips. A transition point or transition is where one clip ends and 
another clip begins.

2. Click the scale box and drag it to the right.

As the Timeline expands, a second “shadow” position indicator 
appears next to the blue position indicator showing the end of a 
single frame, and the two continue to move apart as you expand 
the Timeline.

Scale box

Scale bar
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The position indicator and its shadow mark the beginning and 
end of each frame. 

3. Click the scale box and drag it to the left to contract the expanded 
Timeline. You see less detail but more of the sequence.

Navigating in the Timeline

Two ways to navigate in the Timeline are by using the position 
indicator and the scroll bar.

Using the Position Indicator

You have already used the position indicator — the vertical blue line 
that marks your place in the sequence. You can drag it through your 
sequence to play the sequence, or you can click on a particular 
location, and the position indicator will jump there. Try it now.

The position indicator also determines how some of your commands 
are interpreted. For example, when you perform an edit, the system 
uses the location of the position indicator as the IN point, unless you 
have marked a different IN point.

When you move the position indicator in the Timeline, the smaller 
position indicator within the Composer monitor’s position bar also 
moves. Drag the position indicator again. This time watch the position 
bar of the Composer monitor.

Position indicator Shadow position indicator
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Using the Scroll Bar

The scroll bar functions like any standard scroll bar. 

If your Timeline is contracted and fits the window, you won’t be able 
to scroll, and the controls in the scroll bar will be dimmed. If your 
Timeline is expanded, you’ll need to use it.

Use the Scale box to expand the Timeline, scroll through it, and then 
contract the Timeline.

Using the Track Selector Panel

The Track Selector panel, to the left of the Timeline, provides controls for 
working with multiple tracks. With this one panel, you can select, 
delete, monitor, enlarge, reduce, lock, patch, and move any video or 
audio track.

Scroll bar

Scroll box
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The following illustration shows a sample Track Selector panel. The 
panel might look different, depending on the source material or the 
work under way in the sequence.

The source side (left side) of the panel displays only those tracks 
available for the clip currently loaded and displayed in the Source 
pop-up monitor. In this example, the clip has video on track V1 and 
audio on track A1.

The record side (right side) of the panel displays, by default, two 
tracks of video and four tracks of audio. You can add two additional 
video tracks and four additional audio tracks.

Selecting Tracks

There are also keyboard 
equivalents for 
selecting tracks. Check 
the Keyboard settings 
in the Project window 
Settings scroll list.

When you edit a clip into a sequence, you must make sure that you 
have selected the correct tracks to accomplish the edit you want. You 
select tracks by clicking the track buttons in the Track Selector panel. 
Selected tracks are colored (purple, by default), and deselected tracks 
are gray (dimmed).

Source Track buttons

Sync Lock and Lock buttons

Record Track buttons

Audio Track Monitor buttons

Timecode button

Video Track Monitor buttons

Film Track button

Video Track Monitor button

Audio Track Monitor button
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For example, if you want to edit only the audio from a clip, select only 
track A1 on both the source and record sides and deselect the other 
tracks. If you want to edit only the video, select only track V1 on both 
sides.

Monitoring Tracks

By default, you monitor (view and hear) all tracks in your sequence. 
For this tutorial, you shouldn’t need to change the monitoring. 
However, you can change the monitoring by clicking a Track Monitor 
button on either the source side or record side of the Track Selector 
panel. 

The Video Track Monitor buttons determine whether you see video 
during playback. A Monitor icon indicates the top track that is 
monitored for playback and output. When there are multiple video 
tracks, all tracks below the monitored track are also monitored.

The Audio Track Monitor buttons determine whether you hear audio 
during playback. A Speaker icon (either solid or green) indicates that 
the tracks are monitored for playback and output. However, only the 
track with the green icon is monitored for audio scrubbing.

n Be sure to activate the topmost video track and all audio tracks to view, 
render, or record all the tracks together. Unmonitored tracks are not included 
in playback.

Video Track
Monitor icons

Audio Track
Speaker icons
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Splicing in a Video Clip

You’ve already marked IN and OUT points for the Editor at keyboard 
clip. Now let’s add it to the sequence. Start by reviewing the clip.

1. In the Source Clips bin, open the Editor at keyboard clip.

Look for IN and OUT points. If there are no points, see “Marking 
the First Clip” on page 115.

2. Play the marked portion of the clip by pressing the Play IN to OUT 
(6) key. 

Adding Additional Frames

Now extend the clip by adding a few more frames.

1. Snap the position indicator to the OUT point by clicking the Go to 
OUT button on the Source pop-up Tool palette.

Whenever you use the 
numeric keypad, you 
must press the Enter 
key on the numeric 
keypad after typing the 
number.

2. Type +6 on the numeric keypad and press the Enter key to add 6 
frames to the clip.

3. Mark that frame as the OUT point.

The OUT point automatically moves to the new position.

n You can press and hold the Alt key and click the Mark OUT button, or press 
the O key, to go to the OUT point.
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Splicing in the Clip
Now make the edit.

1. Select the tracks you want to edit:

a. On the source side of the Track Selector panel, make sure track 
V1 is selected. The button should be highlighted in purple, not 
dimmed (gray). If the button is gray, click it.

b. On the record side of the Track Selector panel, select record 
track V1 and deselect all other video and audio tracks. Keep 
the timecode track TC1 selected. 

2. In the Timeline, move the position indicator to the first frame of 
black after the Opening logo.mov clip. Look for the small white 
right angle in the lower left corner of the Composer monitor. 

3. Click the Source pop-up monitor for the Editor at keyboard clip.

4. Click the yellow Splice-in button on the Tool palette or press the 
Splice-in (V) key on the keyboard to splice the clip into the 
Timeline as the third clip.

The Timeline should look like the one in the following illustration.

5. Play some or all of the sequence to review it.
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Splicing a Clip into the Middle of a Sequence

With nonlinear editing, you can splice a clip anywhere in your 
sequence. Let’s try inserting a clip between the Opening Logo.mov 
and Editor at keyboard clips.

1. Open the Eyeball clip.

You’ve already marked IN and OUT points for this clip. If an IN or 
OUT point is missing, see “Marking Another Clip” on page 117. 

2. Select the tracks you want to edit:

a. On the source side of the Track Selector panel, make sure track 
V1 is selected. 

b. On the record side of the Track Selector panel, make sure track 
V1 is selected and all other video and audio tracks are 
deselected. 

Moving to the Head of a Clip

You want to insert the edit between the Opening logo.mov and Editor 
at keyboard clips. To move to the first frame of the Editor at keyboard 
clip:

You can also use this 
technique for snapping 
to the last frame of a 
clip. Click between the 
position indicator and 
the end of the clip.

1. In the Timeline, click in the middle of the Editor at keyboard clip.

2. Press and hold the Ctrl key and click between the position 
indicator and the beginning of the clip. The position indicator 
snaps to the first frame of the Editor at keyboard clip.

Splicing in the Clip

Now splice the clip into the sequence.

1. Click the yellow Splice-in button on the Tool palette or press the V 
key on the keyboard.
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Whenever you splice a clip into the middle of a sequence, the rest 
of the sequence is extended. Your Timeline should look like the 
one in the following illustration.

2. In the Timeline, press the Home key and play the sequence to 
review the new edit.

3. Close the Eyeball clip.

Undoing an Edit

The Eyeball clip doesn’t seem to fit here. You can easily undo the edit 
by choosing Undo from the Edit menu or by pressing Ctrl+Z. Try it 
now.

You can also redo up to 
32 previous edits.

The Undo feature is very useful. You can undo up to 32 previous 
actions listed in the Edit menu.

Splicing in a Music Track

In this section, you lay down an audio clip that contains the music for 
the sequence. The music has already been edited to approximately 
1 minute, which is the length of the final sequence.
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Opening and Marking the Clip

Open and mark the clip.

1. Open the Music track clip.

2. In the Source pop-up monitor, play some or all of the clip.

3. Click the Mark Clip button on the Source pop-up monitor.

Patching Tracks

Before you make the edit, look at the Track Selector panel.

Because the Music track clip has one audio track, the A1 button 
appears on the source side, directly across from the A1 button on the 
record side. If you make the edit now, the music will overwrite the 
narration.

You need to tell the system to edit track A1 from the source clip to 
track A2 of the sequence. You do this by patching one track to another. 
The term patching comes from the electronics field, where it refers to 
temporarily connecting two components.

To patch the tracks, drag the pointer from the A1 button on the source 
side to the A2 button on the record side.

While you are patching, you see a white arrow connecting the two 
tracks. After the patch, you see that the button for source track A1 is 
next to the button for record track A2.
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Selecting the Tracks to Edit
Look at the Track Selector panel again. You need to deselect all record 
tracks except A2. 

1. On the source side of the Track Selector panel, make sure track A1 
is selected (purple, not gray). 

2. On the record side of the Track Selector panel, make sure track A2 
is selected, and deselect all other video and audio tracks.

Splicing in the Clip

Now you’re ready to make the edit.

1. In the Timeline, go to the head of the sequence.

2. Click the yellow Splice-in button on the Tool palette.

The music track should now appear on track A2. Your sequence 
now has one video track and two audio tracks.
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Reviewing Your Edits

Review what you’ve done.

1. Now that you have two tracks of audio, make sure that all tracks 
are being monitored. Make sure the Speaker icons for tracks A1 
and A2 are visible (see “Monitoring Tracks” on page 142).

2. Go to the head of the sequence and play through the sequence.

The music sounds a little loud for the narration. You’ll adjust audio in 
“Working with Audio” on page 168.

Confirming the Duration

The next steps explain how to confirm the duration by displaying the 
master timecode, which is the timecode of your sequence.

1. Look at the top left of the Composer window. If the master 
timecode (Mas) is not displayed, click and open the Tracking 
Information pop-up menu from the gray area above the Composer 
monitor and select Mas timecode.

The master timecode displays the location of the position indicator 
in your sequence.

2. Click the position indicator in the Timeline and drag it to the last 
frame of the sequence.

The master timecode should read 00;00;59;00 (NTSC) or 
00:00:59:00 (PAL), which indicates that the sequence is 59 seconds 
long.

3. Drag the position indicator through the sequence and watch the 
master timecode change.

Now is a good time to close any open pop-up monitors. Close all bins 
too, except for the Sequences bin.
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Next Steps

You’ve started your rough cut. You’ll adjust the audio in the next 
chapter. You’ll also add some clips to fill in the video gap and to 
illustrate what the narrator is talking about.

You can continue to the next chapter, or quit this session (see “Closing 
the Project and Quitting the Application” on page 101). The next 
time you open the project, the windows will be in the same position.



151

CHAPTER 8

Building a Sequence

You’ve started creating your rough cut. Now you can complete the 
rough cut, trim your edits, and adjust the audio levels. In this chapter 
you’ll practice the following tasks:

• Storyboard Editing the Clips

• Overwriting Clips into a Sequence

• Backtiming an Edit

• Rearranging Clips

• Trimming

• Adding the Final Clip

• Working with Audio

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, select your user name and 
the Introducing Avid project, and then click OK. If necessary, open the 
Sequences bin, and then drag the Rough Cut sequence into the 
Composer monitor.

If you have not worked on the previous chapters — Start the 
application, create a new user, select the Introducing Avid project, and 
then click OK. Open the Sequences bin, and then drag the Rough 
Cut 1 sequence into the Composer monitor. Make sure you are familiar 
with marking IN and OUT points and performing splice-in edits.
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Storyboard Editing the Clips

Storyboarding allows you to set up a group of clips in a sequence of 
events, and then load them into the Composer monitor all at once.

Marking IN and OUT Points

The first step in storyboarding is to mark IN and OUT points for each 
of the clips you are going to use. We’ve already marked IN and OUT 
points for you. If you need to reset them, refer to the following table.

Clip Namea

a. The NTSC version of these clips use either drop-frame timecode or 
non-drop-frame timecode, depending on how the original footage was 
shot. See “About Timecode” on page 119.

IN Point 
(NTSC)

OUT Point 
(NTSC)

IN Point 
(PAL)

OUT Point 
(PAL)

Homicide logo 01:37:03:06 01:37:04:28 00:05:10:15 00:05:12:12

Newsroom 06;17;48;03 06;17;50;09 00:06:25:16 00:06:27:12

Editor at keyboard 2 01:26:59:00 01:27:01:04 00:02:37:18 00:02:39:23

Recording session 01:22:23:17 01:22:25:00 00:05:26:06 00:05:27:17

Special effects 01:01:40:20 01:01:42:21 00:03:28:15 00:03:30:15

Lab 1A 01:24:53:19 01:24:57:16 00:04:10:22 00:04:14:20

Lab 1B 01:25:00:11 01:25:07:16 00:04:17:03 00:04:25:12

Trade show 00;03;21;16 00;03;25;17 00:05:45:22 00:05:50:00
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Creating the Storyboard

Next you need to arrange the clips as a storyboard.

1. In the Source Clips bin, click the Frame View button.

2. If you need more space to view the clips, click the lower right 
corner of the bin and drag it to enlarge the window.

3. Choose Fill Window from the Bin menu to arrange the clips in the 
bin.

4. Arrange the following clips in two rows, from left to right, and top 
to bottom, to form the storyboard. You arrange the clips by 
clicking and dragging each clip. Make sure you maintain the order 
of clips as listed below and shown in the following illustration.

- Homicide logo

- Newsroom

- Editor at keyboard 2

- Recording session

- Special effects

- Lab 1A

- Lab 1B

- Trade show

Arranging the clips in this way makes it easier to select the clips 
you want to use in the storyboard. Separate the remaining clips, as 
shown in the following illustration.
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Editing the Clips into the Sequence

Now you’re ready to edit the marked clips into the sequence.

1. Click the Composer monitor, make sure Mas is displayed in the 
Tracking Information display, type 17;25 (NTSC) or 18:00 
(PAL), and press Enter on the numeric keypad.

2. Mark an IN point.

3. Select record track V1 and deselect all other video and audio 
tracks.

4. Select the storyboarded clips all at once.

a. Position the pointer in the Source Clips bin in the blank area 
above and to the left of the Homicide logo clip.
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b. Lasso the clips by clicking and dragging the pointer to the 
right and down, making sure to select all of the storyboarded 
clips, and then release the mouse button. After you select the 
clips, all the names are highlighted in blue.

5. Click on one of the clips (on the image, not the name), and drag 
the group into the Timeline. Release the mouse button when a 
yellow arrow appears in the Timeline.

The clips are spliced into the sequence in the order you specified.

6. Play the sequence to review it. 

Overwriting Clips into a Sequence

In the previous chapter, you spliced clips into a sequence. In this 
section you’ll learn how to overwrite clips into a sequence. An 
overwrite edit replaces a section of a sequence with other source 
footage. An overwrite edit is especially useful when you want to 
replace footage but you don’t want to affect the clips that follow in the 
sequence.
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The Editor at keyboard clip is a little too long. Let’s edit the next clip 
over the last part of the Editor at keyboard clip. 

1. Make sure the Composer monitor is active.

2. Make sure the Mas timecode is displayed in the Composer 
monitor (see “Confirming the Duration” on page 149).

3. Mark an IN point at 00;00;07;08 (NTSC) or 00:00:07:06 (PAL). 

4. Open the Source Clips bin.

5. Open the Eyeball clip. 

6. Check the IN point and OUT point. If there are no points, see 
“Marking Another Clip” on page 117.

When you open a clip, 
source tracks are 
selected automatically.

7. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

8. Click the red Overwrite button on the Tool palette or press the 
B key on the keyboard.

The clip overwrites part of the Editor at keyboard clip.

9. Close the Eyeball clip.

Add two more short clips following the Editor at keyboard clip. Using 
the following clips and edit points, which you marked in Chapter 6, 
follow steps 5 to 9 in the previous procedure. Make sure the position 
indicator is parked on the last frame of the clip you just added.

Clip Name
IN Point 
(NTSC)

OUT Point 
(NTSC)

IN Point 
(PAL)

OUT Point 
(PAL)

Hand and keyboard 01:08:14:18 01:08:16:18 00:01:42:23 00:01:44:23

Editor at keyboard 3 01:23:24:02 01:23:27:00 00:03:07:15 00:03:10:13
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Backtiming an Edit

Backtiming an edit is effectively the reverse of the process you normally 
use for marking footage; instead of marking from the IN points 
forward, you mark from an OUT point backward.

In the sequence, there is a gap between the Editor at keyboard 3 clip 
and the Homicide logo clip. Let’s fill this gap.

1. Go to the last frame of black before the Homicide logo clip and 
mark an OUT point.

2. Go to the first frame of black after the Editor at keyboard 3 clip 
and mark an IN point.

The gap changes to purple.

3. Open the QuickTime Movies bin.

4. Open the Globe.mov clip.

5. Mark an OUT point at 00;00;04;17 (NTSC) or 00:01:09:10 (PAL).

6. Click the red Overwrite button on the Tool palette or press the 
B key on the keyboard.

The gap is now filled.

7. Close the Globe.mov clip and the QuickTime Movies bin.

Rearranging Clips

You can rearrange clips by overwriting material, switching placement 
of material, lifting material, or removing material. Overwriting and 
switching material doesn’t change the length of the sequence. Lifting 
material leaves a gap (also known as filler) and doesn’t affect the 
length of the sequence. Removing material shortens the length of the 
sequence.
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Overwriting with a Three-Point Edit

A three-point edit is an easy way to replace a clip in a sequence. Use the 
Mark Clip button to select the clip in the sequence (or mark an IN and 
OUT point for a segment that’s more than a single clip), and mark 
either the IN or OUT point in the source clip. The system calculates the 
exact duration of the source clip to insert.

Let’s replace the Editor at keyboard 3 clip near the beginning of the 
sequence with the L key clip.

1. To enlarge this area, in the Timeline:

a. Press the Home key.

b. Click the scale box and drag it to the right until you can read 
the label Editor at keyboard 3.

2. Place the position indicator anywhere in the Editor at keyboard 3 
clip.

3. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

4. Click the Mark Clip button in the row of buttons below the 
Composer monitor, or press the T key on the keyboard.

The IN and OUT points appear at the head and tail of the clip in 
the TC1 track of the Timeline. The marked segment changes to 
purple. 

The IN and OUT points also appear in the Composer monitor’s 
position bar.

5. In the Source Clips bin, open the L key clip.

6. Mark an OUT point at 01:11:40:15 (NTSC) or 00:02:03:04 (PAL). Do 
not mark an IN point.

Make sure the V1 timecode is showing in the Tracking Information 
display.
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7. Click the red Overwrite button on the Tool palette (or press the 
B key on the keyboard) to make the three-point edit.

The L key clip replaces the Editor at keyboard 3 clip.

8. Click the scale box and drag it to the left to contract the Timeline.

9. Close the L key clip.

Using Segment Mode

Segment mode provides editing controls for moving, deleting, 
marking, and editing entire segments in the Timeline. A segment is a 
portion of the sequence that consists of one or more clips. There are 
two buttons for editing segments or adding clips: Extract/Splice-in 
(indicated by a yellow arrow) and Lift/Overwrite (indicated by a red 
arrow). These buttons are located at the bottom of the Timeline 
window.

Unlike traditional editing, Segment mode allows you to reposition 
entire segments instantly by using visual controls as though you were 
physically “dragging” portions of your sequence around on a tape. 
You can move clips separately or together, and on one track or across 
tracks.

Extract/Splice-in button
Lift/Overwrite button
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Changing the Order of Clips in a Sequence

Let’s see what it looks like if we reverse the position of two clips in the 
sequence. To move entire clips, use Segment mode.

1. Make sure the position indicator is parked in the L key clip (the 
one you just edited into the sequence).

2. Click the Segment Mode (Extract/Splice-in) button, which is the 
button with the yellow arrow under the Timeline.

When the button is activated, its background changes to light gray.

c Don’t confuse the Extract/Splice-in and Splice-in buttons. The 
Extract/Splice-in button is located under the Timeline; the Splice-in 
button is located on the keyboard (the V key) and on the Tool 
palette.

3. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

4. Click the L key clip, drag it to the left (so it is over the preceding 
clip), and release the mouse button. 

The L key clip should now follow the Eyeball clip.

5. Click the Extract/Splice-in button again to deselect it.

6. Click the Timeline anywhere in the Eyeball clip and review the 
clips you just moved.

Let’s go back to the original order. Choose Undo from the Edit menu.
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Removing Footage from a Sequence

You can remove footage from your sequence, and either close or retain 
the gap that results. The Delete key closes the gap, and the Lift key 
retains the gap.

Removing Footage and Closing the Resulting Gap

The Editor at keyboard 2 clip that was part of the storyboard is too 
similar to the clips at the beginning of the sequence. Let’s remove it 
from the sequence and close the gap that results.

1. Use the scale bar and scroll bar to locate the Editor at keyboard 2 
clip.

2. Click the yellow Segment Mode (Extract/Splice-in) button under 
the Timeline.

To eliminate footage 
that does not start and 
end at a transition, use 
IN and OUT points to 
mark the segment that 
you want to extract. 

3. Click anywhere in the Editor at keyboard 2 clip on track V1.

The clip is highlighted.

4. Press the Delete key on the keyboard.

The selected clip is eliminated and the surrounding clips close the 
gap.

5. Deselect the Extract/Splice-in button by clicking it.

6. Click the Timeline in front of the Recording session clip and play 
the next few clips.

The video no longer matches the narration. You need to retain 
rather than close the gap.

7. Choose Undo from the Edit menu to undo the edit and restore the 
clip.
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Removing Footage and Retaining the Resulting Gap

The Lift key retains the gap after lifting footage from the sequence. Use 
the Lift key if you want to maintain the rhythm of a sequence or the 
synchronization of the video and audio tracks.

Try the edit again, but this time use the Lift key, and replace the clip.

1. Click anywhere in the Editor at keyboard 2 clip.

2. Click the Mark Clip button below the Composer monitor to mark 
IN and OUT points.

3. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

4. Press the Lift key on the keyboard to remove the segment.

The letter equivalent of the Lift key depends on the version of 
your keyboard. For the location of the Lift key, choose Keyboard 
from the Settings scroll list.

The selected segment lifts out and leaves filler in its place.

Replacing a Clip

Now fill the gap with a different clip.

1. Open the Corporate editor clip.

2. Mark an IN point for the clip at timecode 06;16;34;13 (NTSC) or 
00:06:08:07 (PAL).

3. In the sequence, make sure the filler has IN and OUT points. If not, 
click the Mark Clip button.

4. Click the red Overwrite button on the Tool palette or press the 
B key on the keyboard.

The filler has been replaced by the new clip.

5. Close the Corporate editor clip and the Source Clips bin.

6. Move the scale bar all the way to the left to compress the Timeline, 
which lets you see the entire sequence.
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Trimming

Trimming allows you to adjust incoming and outgoing frames of your 
clip. There are two types of trims: dual-roller and single-roller. When 
you trim, you are working in Trim mode. In Trim mode the Composer 
monitor changes and new editing buttons appear.

To trim a transition, at least one of the clips needs media in addition to 
the media displayed in the Timeline (see “Sequences” on page 72).

Adjusting Both Sides of a Transition (Dual-Roller Trimming)

Use a dual-roller trim to adjust both sides of a transition at the same 
time, adding frames to one clip while subtracting frames from the 
adjacent clip. The total duration of the sequence does not change.

Let’s tighten the Lab 1A/Lab 1B transition. (You’ll smooth the 
transition with a dissolve effect in the next chapter).

1. Place the position indicator near the Lab 1A/Lab 1B transition, 
and click the Trim Mode button on the Tool palette.

The position indicator snaps to the transition, and an icon 
representing two rollers appears.

The Composer monitor shows the last (tail) frame of the Lab 1A 
clip on the left, and the first (head) frame of the Lab 1B clip on the 
right.

New buttons appear below the trim windows. During a 
dual-roller trim, both frame counters are purple.

 

Dual-roller icon
at the trim transition
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2. Play the transition by clicking the Play Loop button.

The transition plays repeatedly.

3. To stop the playback loop, click the Play Loop button again.

4. Click the Trim Left 10 Frames button three times.

Transition Effect
palette

Outgoing clip Incoming

Frame
counters

Trim Frame buttons buttonPlay Loop

clip

 

Trim Right
10 Frames

Trim Right
1 Frame

Trim Left
1 Frame

Trim Left 
10 Frames
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You can also trim by 
dragging the 
Dual-Roller icon.

This action adds 30 frames to the head of the incoming clip and 
removes 30 frames from the tail of the outgoing clip. The duration 
of the video track remains unchanged.

5. Play the transition again by clicking the Play Loop button.

6. Do one of the following to exit Trim mode:

- Click the Trim Mode button on the Tool palette.

- Press the Left Arrow key on the keyboard.

Single-Roller Trimming

In the previous trim, you trimmed both the head and the tail clips an 
equal number of frames, adding to one side and subtracting from the 
other. Now let’s trim the tail of one clip without affecting the head of 
the next clip. This is a single-roller trim. You’ll also use a different way 
of entering Trim mode.

The Trade show clip begins a little too quickly for the narration. Let’s 
extend the Lab 1B clip while keeping the same start of the Trade show 
clip.

1. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

2. Move the position indicator to the Lab 1B/Trade show transition.

3. Enter Trim mode by lassoing the Timeline tracks.

a. Click the pointer above all the Timeline tracks, just to the left 
of the transition, but below the title bar. In this example, click 
above and to the left of the position indicator. 

 

Click here to
lasso the
transition.
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b. Drag the pointer down and to the right to surround the
transition, and release the mouse button.

The trim rollers appear.

4. In the Composer window, click the left frame counter (A-Side Trim 
counter).

Your trim will only affect the outgoing clip, which is in the left 
Trim monitor. The left frame counter remains purple, while the 
right one is deselected. A single roller appears in the Timeline.

5. On the numeric keypad, type +40 and press Enter.

This moves the transition 40 frames to the right.

Left frame
counter
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6. Play the transition by clicking the Play Loop button.

7. Exit Trim mode by pressing the Left Arrow key on the keyboard or 
by clicking the Trim Mode button on the Tool palette.

Adding the Final Clip

We have supplied you with another QuickTime movie, titled Closing 
logo.mov. This clip needs to be edited to sync with the music, so use 
timecode to set the IN point in the sequence. 

1. Open the QuickTime Movies bin.

2. Open the Closing logo.mov clip.

3. Click the Mark Clip button to mark the entire clip for editing.

4. Click the Composer monitor.

5. Mark an IN point at 00;00;44;02 (NTSC) or 00:00:44:02 (PAL).

Use the Mas setting in the Tracking Information display.

6. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

7. Click the red Overwrite button on the Tool palette or press the 
B key on the keyboard to make the edit.

8. Close the Closing logo.mov clip and the QuickTime Movies bin.

9. Play your sequence to review your work.

There might be a small gap between the end of the Trade show clip 
and the beginning of the Closing logo.mov clip. 



168

Perform a dual-roller trim to close the gap.

1. Place the position indicator on the first frame of black after the 
Trade show clip and click the Trim Mode button on the Tool 
palette.

You should see two rollers appear at the transition.

2. Drag the rollers until they reach the beginning of the Closing 
logo.mov clip.

The rollers will stop when they reach the beginning of the next 
clip.

3. Click the Left Arrow key to exit Trim mode.

4. Play the last two clips of the sequence.

Working with Audio

In this section, you work with the Audio Mix tool to adjust the balance 
and volume of the sequence. 

Adjusting Audio Pan (Balance)

The narration for the sequence plays out of one speaker and the music 
plays out of another. You can adjust the audio pan (balance) so the 
sound plays equally from both speakers.

1. Clear any IN or OUT points from the sequence by pressing the 
G key on the keyboard.

2. Select record tracks A1 and A2.

3. Move the Timeline position indicator to any point in the Timeline 
that includes both A1 and A2.

4. Choose Audio Mix from the Tools menu.
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The Audio Mix tool appears.

5. Click and hold the Pan Level box for track A1 to open the Pan 
Adjustment window.

The Pan slider appears.

To snap the slider to 
MID, press and hold the 
Alt key and click the 
Pan Level box.

6. Drag the Pan slider to the middle of the scale until it reads MID, 
and then release the mouse button.

7. Open the Pan Adjustment window for track A2 and drag the Pan 
slider until it reads MID. Release the mouse button.

You can change the pan 
settings for an entire 
project in the Audio 
Settings dialog box.

8. Play a portion of the sequence to check the speaker balance.

Level sliders

Pan Level boxes

Drag the Pan slider.

Click and hold here to 
open the Pan
Adjustment window.
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Adjusting Audio Level

The music is a little loud for the narration. Let’s raise the volume of the 
narration by using the Audio Mix tool. 

1. The Audio Mix tool should already be open. If not, choose Audio 
Mix from the Tools menu.

2. Place the position indicator anywhere within the Narration clip.

3. In the A1 area of the Audio Mix tool, move the A1 Audio Level 
slider to level +5.0 by doing one of the following:

- Drag the slider to level +5.0.

- Click the slider and type +5.

- Click the slider and press the Up Arrow or Down Arrow key 
on the keyboard to reach level +5.0.

4. Play a portion of the sequence.

Adjust the audio level further, depending on your preference.

5. Click the Close button to close the Audio Mix tool.

You can make further adjustments to the narration or music track by 
using the Audio Gain Automation feature. See the Avid Xpress DV 
User’s Guide or Help.

Next Steps

You’ve completed and refined your rough cut. You can continue to the 
next chapter to add effects, or quit this session (see “Closing the 
Project and Quitting the Application” on page 101). The next time 
you open the project, the windows will be in the same position.
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CHAPTER 10

Creating Titles

The Title tool lets you create text and graphics that you can edit into a 
sequence. In this chapter you’ll add titles to your sequence by 
completing the following tasks:

• Creating a New Title

• Saving a Title

• Editing the Title into the Sequence

• Fading a Title

• Editing a Saved Title

• Renaming Your Sequence

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, select your user name and 
the Introducing Avid project, and then click OK. If necessary, open the 
Sequences bin, and then drag the Rough Cut sequence into the 
Composer monitor.

If you have not worked on the previous chapters — Start the 
application, create a new user, select the Introducing Avid project, and 
then click OK. Open the Sequences bin, and then drag the Rough 
Cut 3 sequence into the Composer monitor. 
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Creating a New Title

For complete 
information on creating 
and editing titles, see 
the Avid Xpress DV 
Effects Guide or Help.

Let’s create a title that illustrates part of the narration.

1. In the Timeline, place the blue position indicator in the middle of 
the Testing board clip.

2. Choose New Title from the Clip menu.

The Title Tool opens on top of the Composer and Timeline 
windows.

Toolbar

Safe action
area

Video
background

Safe title
area
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The Title tool includes the following features:

To get information on 
items in the toolbar, 
position the pointer on 
an object, click the right 
mouse button, and 
choose What’s This? 
from the pop-up menu.

- Two grids that indicate areas of the image that are safe for 
broadcast. The outside grid outlines the safe action area and 
the inside grid outlines the safe title area. The safe title and 
safe action areas do not apply if you are creating a video for a 
CD-ROM or the Internet.

- Video background for the title, based on the location of the 
position indicator when you open the Title tool.

- A toolbar that includes many controls for creating, adjusting, 
and saving your titles.

3. Click the Text Tool button. If it is already selected on the toolbar, 
the pointer changes to an I-beam when you click in the Title Tool 
window.

4. Click in the left side of the safe title area, below the 
picture-in-picture.

A blinking insertion point appears.

5. Type product innovation.

6. The following values might already be selected. If not:

a. Click the Selection Tool button on the toolbar, then click the 
title text.

Object selection handles surround the title.

b. Choose 48 from the Font Point Size pop-up menu.

c. Choose Arial from the Font Selection pop-up menu.

d. Click the B button for bold and click the I button for italics.
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Adding a Shadow
Adding a shadow to the title text will make it easier to read. Type a 5 
in the Shadow Depth Selection text box and press the Enter key.

By default, the Title tool uses a shadow that falls below and to the right 
of the text. For more information about changing the type of shadow 
and how it falls, see the Avid Xpress DV Effects Guide.

Positioning and Aligning Text

You might need to move the text so that it aligns with the edge of the 
safe title grid.

1. Select the first line of text.

2. Choose Align to Frame Left from the Alignment menu.
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Your title should look similar to the one in the following illustration.

There are many adjustments you can make in the Title tool. For now, 
let’s save the title.
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Saving a Title

Now save your title.

1. Open the Source Clips bin. You’ll be storing the title here.

2. Click in the Title Tool window.

3. Choose Save Title from the File menu.

The Save Title dialog box appears.

4. Type product innovation in the Title Name text box.

5. Choose Source Clips from the Bin pop-up menu.

6. Accept the default drive and resolution.

7. Click Save.

The title appears in the Source Clips bin.

8. Click the Close button to close the Title tool. 

Editing the Title into the Sequence

Now add the title to your sequence.

1. Double-click the product innovation title clip.

The title opens in a Source pop-up monitor. 

2. Add a new video track (V3) by choosing New Video Track from 
the Clip menu.

3. Patch source track V1 to record track V3 by clicking the V1 Source 
Track button and dragging it to the V3 Record Track button (see 
“Patching Tracks” on page 147).

4. Make sure source track V1 and record track V3 are selected, and all 
other video and audio tracks are deselected.

5. In the Source pop-up monitor, set an IN point at the beginning of 
the clip.
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6. In the Timeline, set an IN point at 00;00;31;22 (NTSC) or 
00:00:31:22 (PAL) which is approximately where the narrator 
begins to say “product innovation.”

7. Set an OUT point at 00;00;33;19 (NTSC) or 00:00:33:19 (PAL) to 
sync with the end of the Testing board clip.

8. Click the red Overwrite button on the Tool palette.

This adds the title to the V3 video track. Now you have to render 
the title, in the same way as you would render an effect.

9. In the Timeline, place the position indicator on the Title Effect icon.

10. On the Tool palette, click the Render Effect button and click OK.

The Avid Xpress DV system renders the effect and creates a file for 
the title.

11. Close the product innovation title clip.

12. Play the part of the sequence that includes your title.

Fading a Title

You can have the title fade in and out:

1. Place the position indicator on the Title Effect icon.

2. Click the Fade Effect button on the Tool palette.

3. Type 10 frames in each of the text boxes.

4. Click OK.

The effect now has a blue dot. You need to render the effect again.

5. Click the Render Effect button and click OK.

6. Play your sequence from just before the Testing board clip.
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Editing a Saved Title

You can edit a saved title to change the content, font, and so on. You 
can create a new title by editing a saved title and saving it with a new 
name. 

1. In the Source Clips bin, Ctrl+double-click the product innovation 
title.

The title opens in the Title Tool window.

2. Make sure the Text Tool button is selected.

3. In the Title Tool window, click the beginning of the existing title 
and drag the cursor to select the text.

4. Replace the text with the words a path to the future. Keep 
the same settings as the previous title.

5. Click the Selection tool and then drag the title to the upper right.

6. Choose Align to Frame Right from the Alignment menu.

Changing Color

By default, the text is white. Let’s change the color of the new title.

1. Click the Selection tool and then click the title text.

2. Click and hold the Fill box. 

The Title Tool Color Picker appears.

You can “tear off” the 
Title Tool Color Picker 
window by dragging it 
to another location.
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3. Drag the mouse pointer over the band of colors at the top of the 
Title Tool Color Picker. When you find a color you want to use, 
release the mouse button.

The color is applied to the title.

Saving the Title

Next, save the title with a different name.

1. Choose Save Title As from the File menu.

2. In the Title Name text box, type a path to the future.

3. Click Save.

4. Close the Title tool.

Editing the Title

Now edit the title into the sequence in the same way that you edited 
the previous title.

1. Open the a path to the future clip.

2. Click the Timeline and mark an IN point at 00;00;35;19 (NTSC) or 
00:00:35:19 (PAL), approximately where the narrator begins to say 
“a path to the future.”

3. Mark an OUT point at 00;00;37;15.

4. Patch source track V1 to record track V3.

5. Click the red Overwrite button on the Tool palette.

6. Click the Fade Effect button.

7. Render the title.

8. Play the sequence from the beginning to review your work.
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Renaming Your Sequence

If you’re satisfied with your sequence, change the name from Rough 
Cut to a name of your choice.

1. In the Sequences bin, click the name Rough Cut.

2. Type a new name, such as Final Sequence.

Next Steps

You’ve finished editing your sequence. There are probably changes 
and refinements you’d like to make. If you have time, try making these 
changes. Consult the Avid Xpress DV User’s Guide, Avid Xpress DV 
Effects Guide, and Help for information on all the features of the 
product and how to use them.

The next chapter describes how to output your sequence. You can 
continue to the next chapter, or quit this session (see “Closing the 
Project and Quitting the Application” on page 101).
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